Handout Disclaimer

Disclaimer: the following document was distributed as a handout for
the Analyzing Data for Beginner Series and is designed to enhance the
sessions you have attended. NSH makes no representations to the
factual correctness of any information contained herein. All of the
content comprising this handout is the exclusive property of the
presenter and the national society for histotechnology. It may not be
copied, reproduced, distributed, displayed or transmitted without the
consent of the presenter or the National Society for Histotechnology.
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Does every Hallmark
Christmas movie have the
same plot?

Am I still going to watch two
people fall in love in a small
town when it's snowing and
they live happily ever after?
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Credit: Gareth Starkey

GET ALL THE
INFORMATION You CAN,
We'LL THINK oF A
USE Fof (T LATER,.
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What we will cover today:

Part 1: What is Data?

Part 2: Preparing Data for Analysis
Part 3: Analyzing Data
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Part I: What is Data?

. Summarize where data fits into the evaluation cycle.

Identify what data is present and available to you.
Define data

Classify types of data

BwNos

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Connactiog. Gmpomering. Fnowoing




Process of Evaluation

Why bother? What is the outcome?

Why and What to
Measure

Draw Conclusions Gathering Data

What
Changes/Decisions as a How to Measure It
Result? Interpretation

How to Analyze the

Results

Observations ATONAL SOCETY FOR
HISTO'IECI"NOLOGY

Conacteg fmpomerng bnovating.




— Total Discussion Posts Members Open Forum by

March Apil May June
m2021 Total Dis. Posts

op Contributors - October 2022

op Thread from October 2022
lame

% threads
with a best
answer

% threads
with no
replies

% threads with a reply

flembers 26 38%
orum

769% 231%

Sy —— -

answer to.

July
m2022

Aug
Total D1

Total Posts

5 George with the surprise win!

Total Replies

# of threads
unanswered
for greater
than 3 days

Avg. time to | Avg. time to
reply  |bestanswer
(d:hh:mm) | (d:hhzmm)

#of unique
posters

#of unique
responders

I
Discussion Replit

Feb March Aprl  Msy e July A Sept  oct Mav Dec
2021 Replies to Dis. 2022 Replies to Discussion

SEARCH TERMS LAST 90 DAYS

H gihc
digital pathology
m free ceus

W ihc validation

W zombie

W mohs

A

INATIONAL SOCIETY FOR

HISTOTECHNOLOGY

Connactng Gmpowering Fravaing




Examples of Questions

« How does my staff feel about work schedules?
 Should my lab use an automated embedder?
» Should we invest in a new database?
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Process of Evaluation
Why bother? What is the outcome?

Why and What to
Measure

Draw Conclusions Gathering Data

What
Changes/Decisions as a How to Measure It
Result? Interpretation

How to Analyze the

Results

Observations ATONAL SOCETY FOR
HISTOTECHNOLOGY

Conmacteg fmpomerg bnovating.

There is a lot of data available to you. In most cases this step is going to be done by
someone who is an evaluator, but if you are asked to create the measurement tool (like
some kind of ordinal tool, like a liekrt scale)
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Part I: What is Data?

Summarize where data fits into the evaluation cycle.
Identify what data is present and available to you.
Define data

Classify types of data

HwWwbhN -~
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Lets move onto the last learning objective for this section, and that is really the second part
of the cycle. Change slide
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« How does my staff feel about work
schedules?

What Data Do You How to Measure/Count
Already Have Access To?

* LIS canned reports

« Emails

* Error logs

» Budgets (current and past)
* Page views

* Search terms

* Invoices

« Sign out logs

« Staff meeting agenaas

* Leave requests *
H ATIONAL SOCIETY FOR

N
ISTOTECHNOLOGY

Connacting. Empowering. Inovoling

Data is something that all of you are using the in the lab, whether formally by utilized
canned reports from your LIS, invoices, document access reports and logs. Unless you are
engaging in a complex research study, this type of data is what you can use.
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Okay, so data exists all over the place.
But how do | know what | am looking
at?
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Part I: What is Data?

Summarize where data fits into the evaluation cycle.
Identify what data is present and available to you.
Define data

Classify types of data

HwnN =
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Lets move onto the last learning objective for this section, and that is really the second part
of the cycle. Change slide




What is Data?

- Factual information (such as measurements or statistics)
used as a basis for reasoning, discussion, or calculation
(taken from Merriam-Webster)

r;i"nlr A ,&mn

Reasonmg, }
di ’“i
|scu55|on .,
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| think this is great definition of data because it doesn’t just mention the calculation. This is
because people tend to forget there is a lot of different types of data out there and we use
that data to solve problems, makes decisions, and identify patterns every day.
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Types of Data

Quantitative: its numerical
in nature and can include
things like, test scores,
temperatures, click rates.

Number of leave requests

Qualitative: its descriptive in
nature, like color, types of
college degrees, and frequency
can be calculated. Also known
as categorical.

Type of leave request

NATIONAL SOCIETY FOR
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Identify if the following are
Qualitative or Quantitative

The baby weighs 20 pounds
The workshop attendees rated the event highly effective
The sky is blue
There were 200 IHC requests this month
There were 26 sick leave requests in Q2
Joe is 6 foot 2

A
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Data is...

* Factual information made up of qualitative and/or
quantitative variables that is an important piece in the

evaluation and reasoning process.

Reasoning, '
discussion,

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
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Data is a part of the evaluation or decision making process. It is NOT the decision. Itisan

AMAZING resource to answer questions though.
You do not have to be processing large data sets to get answers — in fact what we will be

working with in the remaining part of this presentation will be sample of data — not full

populations.

18



Part I: What is Data?

Summarize where data fits into the evaluation cycle.
Identify what data is present and available to you.
Define data

Classify types of data

N -

Why does type of data matter?

It determines the kinds of statistical
tests and measures that can be used.
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How to Measure It

Now that we know that there is qualitative and quantitative data, lets dive even deeper

into what kins of qual and quan exists — and how you can, or already are, using it!
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Types of Data

+ Qualitative

Non-numerical data that is categorical,
such as yes/no responses or eye colour

& Quantitative

Data that can be measured with
numbers, such as duration or speed

A

y
m i# Continuous * Nominal = Ordinal

Whole numbers that can't Numbers that can be broken mig used for naming Data used to describe i
be broken down, such as down, such as height or variables, si = 7

air colour of value oS 1 = happy, 2
a number of items weight = neutral, 3 = unhappy
A
{ 1
Interval I Ratio
Mumbers with known differences Numbers that have measurable intervals
between variables, such as time where difference can be determined, such
as height or weight

. INATIONAL SOCIETY FOR
https://studyonline.unsw.edu.au/blog/types-of-data iﬁﬂgjﬂfﬁv

Continuous data is also associated with two types of measurement — internval and ratio.
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Nominal:

nom-i-nal ( ‘nd-ma-nel«) ) ‘nam-nal
1 :of relating to, or being a noun or a word or expression taking a noun construction

2 a :of, relating to, or constituting a name

b : bearing the name of a person

3 a :existing or being something in name or form only

| nominal head of his party ;T:i;r

-

(fro m M e rri am _We b Ste r) Data used for namino Data used to describe the order

variables, sucn as hair colour of values, such as 1 = happy, 2
= neutral, 3 = unhappy

wi

21



Nominal Data- Categorical

Nominal data are categorized according to labels which are
purely descriptive—they don’t provide any quantitative or
numeric value. Nominal data cannot be placed into any
kind of meaningful order or hierarchy.

Examples: -

¢ Eye COIOr Non-numerical data that is categorical,
. Typ e Of St a | n such as yes/no responses or eye colour
» Gender

« Car color = Ordinal

Data used for namino Data used to describe the order
variables, sucn as hair colour of values, such as 1 = happy, 2
= neutral, 3 = unhappy

wi

Use mode and frequency to statistically measure nominal.
How responses vary: how do men and women answer the same questions?




Ordinal:
ordinal ... adjective

1 :of aspecified order or rank in a series

2 :of orrelating to a taxonomic order

Non-numerical data that is categorical,
such as yes/no responses or eye colour

Data used for naming Dawe “1sed to describe the ord=;
variables, such as hair colour of values, such as 1 = happy. 2
= neutral, 3 = unhappy

wi
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Ordinal Data- Categorical

Ordinal data are categorical (non-numeric) but may use numbers
as labels - BUT CAN BE RANKED NATURALLY.

 Grades/Marks = Qualttative

MNon-numerical data that is categorical,

(A, B,C,O, M E,etC) such as yes/no responses or eye colour
 Education level

« Income level (low, middle, = ordinal

upper middle class, etc.) Data used for naming  Daia tsed to describe the o
- . ! variables, such as hair colour of values, sucn as 1 = happy, 2
« Satisfaction levels = neutral, 3 = unhappy

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Connactiog. Gmpomering. Fnowoing

https://careerfoundry.com/en/blog/data-analytics/what-is-ordinal-data/#what-is-ordinal-
data-a-definition
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Likert Scale - ordinal (hierarchy, categorical)

https://www.questionpro.com/blog/what-is-likert-scale/

QuestionPro
LIKERT SCALE EXAMPLES

e Bk

AGREEMENT FREQUENCY IMPORTANCE INTEREST

Strongly Agree Very Frequently Extremely Important Very interested
Agree Frequently Very Important Somewhat interested
Neutral Occasionally Moderately Neutral

Disagree Rarely Important Somewhat

Strongly Disagree Never Slightly Important uninterested

Not important at all Very uninterested

NATIONAL SOCIETY FOR
*STOTECHNOLOGY
L T —

In this example of an LIS — what kind of data is the Task (nominial)
What kind of data is the priority — ordinal

25



7"1 CoTaer T30 meESPOTTSIONE l"dl['UIUg
mbedded Priority Al PS20- Al
mbedded Priority Al PS520- Al4
mbedded Priority 20- Al PS20- Al-T,
mbedded Priority 520- Al PS20- Al
PS20- Al PS20- Al
PS20- Al PS20- Al
mbedded Priority PSs20 Al PS20- Al
mbedded Priority PS20- Al PS20- Al
mbedded Priority PS20- Al P520- Al-
mbedded Priority 5520 Al 5520- Al ENT Senice
mbedded Priority 5520- Al 5520 A113 ENT Senice
mbedded Priority 5520- Al 5520- A1-9 ENT Senvice
mbedded Priority §520 Al S820- Al Derm Service
mbedded Priority 5520~ A2 5520 A21 ERG Derm Senvice
mbedded Priority 5520- A3 5520 A3 H&E Derm Senvice
|mbedded Priority S320- Ad 5520 Ad1 H&E Derm Service
mbedded Priority S820 A5 8520 A5-1 H&E Derm Service
mbedded Priority S520- AB §820- AB-1 ERG Derm Senvice
mbedded Routine Surgical S§820- Al §820- Al-2 HEE FS GYN Surg Semvice
Permanent FS/TP Slides
mbedded Routine Surgical SS820 A10 5820 A10-1 HER2 IHC GYN Surg Senvice
FS/TP Slides
mbedded Routine Surgical 5520- AN 5520- A1 H&E GYN Surg Senice
FS/TP Slides
mbedded Routine Surgical S520- Al2 S§S820- Al241 H&E GYN Surg Service
FS/TP Slides
mbedded Routine Surgical S820- A2 8820 A2-1 H&E GYN Surg Service
FS/TP Slides
mbedded Routine Surgical 5520- A3 5520- iA3-1 HERZ2 IHC GYN Surg Service
FS/TP Slides
mbedded Routine Surgical S5S20- Ad SS520- Ad1 H&E GYN Surg Senvice —
FS/TP Slides JLOGY
mbedded Routine Surgical 5520- A5 5520 AS-1 H&E GYN Surg Senvice o oo
ES/ID Slidac

In this example of an LIS — what kind of data is the Task (nominial)
What kind of data is the priority — ordinal
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Categorical

Non-numerical data that is categorical,
such as yes/no responses or eye colour

Data used for naming Data used to describe the order
variables, such as hair colour of values, such as 1 = happy, 2
= neutral, 3 = unhappy

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Convacteg fmpomeing Inowolig.
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Is the Question Nominal or
Ordinal?

1.
2.

B

Are you left handed or right handed?

How satisfied are you with your pizza delivery service? 1 - not
satisfied, 2 - satisfied, 3 - very satisfied

What kind of house do you live in?

What kind of pet do you have?

Are you willing to work extra shifts? | am willing to work any
extra shifts, | am willing to work extra shifts if given notice, | am
willing to work extra shifts occasionally, | am not willing to
work extra shifts.

Remember, nominal has no hierarchy... a!m?ecﬁgf&v

Connacting. Empowedng. Fnovoing.

Write your response down, or type in the chat
Nominial

Ordinial

Nominal

Nominial

Ordinial

28



Types of Data

& Quantitative

Data that can be measured with
numbers, such as duration or speed

A

y
i# Continuous

Non-numerical data that is categorical,
such as yes/no responses or eye colour

le numbers that can't Numbers that can be br, Data used for naming Data used to describe the order
be b n down, such as down, such as hejgfit or variables, such as hair colour of values, such as 1 = happy, 2
anu i = neutral, 3 = unhappy
I 1
Interval I Ratio
Numbers with known differences Numbers that have measurable intervals
between variables, such as time where difference can be determined, such

as height or weight

https://studyonline.unsw.edu.au/blog/types-of-data iﬁ's‘f&"é"éﬁ”ﬁéiéﬁv

Connacting. Empowedng. Fnovoing

Continuous data is also associated with two types of measurement — internval and ratio.
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@ Quantitative

°
D I s c ret e: Data that can be measured with

numbers, such as duration or speed

A

diS crele adjective |

I# Continuous

. . = A T b
dis-crete di-'skrét «) dis- Whole_nu;n?frs that _can Numbers that can bg broken
' De Uiunes 22000, auUCh 88 down, such as height or
a number of items weight

1 :constituting a separate entity : individually distinct

several discrete sections

2 a :consisting of distinct or unconnected elements : NONCONTINUOUS

b :taking on or having a finite or countably infinite number of values
| discrete probabilities

a discrete random variable

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs




Discrete Data

Discrete data is numeric. They do not have to be whole
numbers. You count discrete data.

@ Quantitative

Data that can be measured with
numbers, such as duration or speed

J\ 1
1 oo

Whole numbers that can't Numbers that can be broken
be viune.. S, such as down, such as height or
a number of items weight

Examples:
* Number of employees
* Number of IHC tests run

» Favorite ice cream flavor among a

group (counted)

« Number of responses to a survey

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Conmectog. mpomesng. Poovotg

TIONAL SOCII

Its how we make categorical data count!
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Discrete Data Example

Priarity Block Container *3 Task Lab Responsible Pathologist Case Flags

Embedded Priority PS20- Al PS20- Al H&E RENAL

Embedded Priority PS520- Al PS20- Al4 H&E RENAL

Embedded Pricrity PS20- Al PS20- AT H&E RENAL

Embedded Priority PS20- Al PS§20- Al H&E

Embedded Priority PS20- Al PS20- Al4 ERG

Embedded Priority PS20- Al PS20- A7 H&E G O e S fro m

Embedded Priority PS20- Al PS20- Al HAE FS

Embedded Priority PS20- Al PS20- Al4 H&E .

Embedded Priority PS20- Al PS20- AlT H&E d I d t t

Embedded Priority 5520- Al 8520- Al-11 H&E O r I n a a a O

Embedded Priority 5520- Al §520- Al-13 H&E .

Embedded Priori §520- A1 $s20  A19 H&E '

Embedded Prmfi:; 5520- Al §520- Al ERG d I S C rete H

Embedded Priority 5520- A2 8820 A2-1 ERG

Embedded Priarity S520- A3 5520 A3-1 H&E Derm Semvice

Embedded Priority $520- A4 $820- Ad-1 H&E Derm Semvice

Embedded Priority §520- A5 §520- A5-1 H&E Derm Senice

Embedded Priority §520- AB 8820- AB-1 ERG Derm Senice

Embedded Routine Surgical $520- Al 8§820- A1-2 H&EFS GYN Surg Senice

Permanent FS/TP Slides

Embedded Routine Surgical §520- A10 §520- A10-1 HER2 IHC GYN Surg Senice
FSITP Slides

Embedded Routine Surgical 5520 AN §520- A1 H&E GYN Surg Senice
FS/TP Slides

Embedded Routine Surgical S520- A12 §820- Al2-1 H&E GYN Surg Senice
FS/TP Slides

Embedded Routine Surgical 8520- A2 £820- A2-1 H&E GYN Surg Senvice
FS/TP Slides

Embedded Routine Surgical 5520- A3 $520- A3-1 HERZ IHC GYN Surg Service TONAL SOCIETY FOR
FS/TP Slides JTECHNOLOGY

Embedded Routine Surgical S§520- Ad §520- Ad-1 H&E GYN Surg Senice rocing Empomerng. Provotnd
FS/TP Slides

Going back to this LIS data, we can calculate the frequency of the priority or the task. Then
it goes from ordinal data to discrete!
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Continuous:
continuous adjective

con-tinu-ous [ kan-'tin-yu-as «)

1 :marked by uninterrupted extension in space, time, or sequence

The batteries provide enough power for up to five hours of continuous use.

2 ofafunction : having the property that the absolute value of the numerical
difference between the value at a given point and the value at any pointin a
neighborhood of the given point can be made as close to zero as desired by
choosing the neighborhood small enough

TIONAL SOCIETY FOR

onnacting. Empowering. novoing

NA]
*STOT ECHNOLOGY
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Continuous Data

Continuous data is numeric and you measure it (height,
weight, temperature). Its real defining factor is that it can be
counted and change over time. It's the most complex, but
also can be analyzed in the most number of ways!

@ Quantitative

Data that can be measured with
numbers, such as duration or speed

1

14 Continuous
Whole numbers that can . Numbers that can be broken
be broken down, such as down, such as height or
a number of items wegii

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Continuous Data
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Notice that we cannot connect the points since the numbers
between 1 and 2, 2 and 3, 3 and 4 do not exist.

Discrete data

Selling 1.5 cars makes no sense

Cost ]
80000 e —
60000 [— — 1+
40000 @ ;

12
20000 @

1 2 3 4
Number of cars sold

Discrete vs Continuous

https://www.basic-
mathematics.com/discrete-and-
continuous-data.html

Continuous data

Selling 1.5 pounds makes sense

|
Cost |
|
2 =t DA

6 |

3 |

|

|

1

Number of pounds of grapes sold

2

3

4

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Identify if the following are
Discrete or Continuous

The baby weighs 7 |bs 6 ounces pounds
There were 200 IHC requests this month
The lab was 65 degree Fahrenheit

The lab has 6 employees

It took the staff 2 days and 3 hours to
complete the safety training.

ok wnh e

Remember, counting vs measuring... g!m%'ecmg:o%v

Connacting. Empowedng. Fnovoing

Continuous
Discrete
Continuous
Discrete
Continuous




Two Types of Continuous Data

numbers that can't Numbers that can be broken

“® Nominal

ken down, such as down, such as height or
wmber of items weight
A
[ _ D!
© Interval I Ratio
Numbers with known differences Numbers that have measurable intervals
between variables, such as time where difference can be determined, such
as height or weight
Interval: Ratio:
Year Weight
Credit score Error rates

SAT test Crime rate

Temperature Length of time
(CorF)

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Connactiog. Gmpomering. Fnowoing
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Provides:

The "order” of values is
known

“Counts,” aka
“Frequency of Distribution”

Mode
Median
Mean

Can gquantify the diference
between each value

Can add or subtract values
Can multiple and divide
values

Has True zero"

Mominal

Ordinal

Interval

v

%

e L RN R

Ratio

% L X LK %

%

-

LAL SOCIETY FOR
....... ZCHNOLOGY

Connactng Gmpowering Fravaing

https://www.mymarketresearchmethods.com/types-of-data-nominal-ordinal-interval-

ratio/
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Part I: What is Data?

v'Summarize where data fits into the evaluation cycle.
v'Define data.

v'Identify what data is present and available to you.
v'Classify types of data.

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Part 1 Recap!

Launch the quiz!!!

1. Determine purpose, Gather data,
Analyze results, Interpret data

Qualitative
Discrete
Ordinal
True
Continuous al

INATIONAL SOCIETY FOR
ISTOTECHNOLOGY

Connacting. Empowedng. Fnovoing
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Part ll: Preparing Data for Analysis

1. Explain the impact of dirty data
2. Dissect a data cleanse

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs

Cleansing check list, activity with excel short cuts, use of find and replace, etc. Do a
observation breakout with the data. 25 minutes — 10 lecture, 5 observation, 5 review. Take
it back to quantifying the qualitative.

42



Evaluation Life Cycle

Why bother? What is the outcome?

Why and What to
Measure

Draw Conclusions Gathering Data
What

Changes/Decisions as a How to Measure It
Result? Interpretation

How to Analyze the
Results

Observations *mmmm
HISTOTECHNOLOGY
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Preparing the Data: Cleansing

60-80% of a data scientists time
is spent cleaning data.

« Data Scrubbing: “The procedure of modifying or removing
incomplete, incorrect, inaccurately formatted, or repeated
data in a database.” (Technopedia).

« AKA: Cleaning, scrubbing, dirty data, unclean data
- Extractions of data or databases

NATIONAL SOCIETY FOR
*STOTECHNOLOGY
Commactrg mpowerng wrrorvs

These are the types of issues you may encounter...move to next slide
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Example

Im trying to make a budget or
staffing decision based on the
testing numbers.

Test Cost

SU = $25.00
TC =$20.00
TN = $15.00

SU = 8, total cost $200.00
TC =15, total cost $300.00
TN =51, $765.00

So, | budget $1265

Company Testing Site

2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
2337
[2337

655715
662695
662699
687630
759333
770665
70677
810308
810310
813164
813168
813170
813172
813174
813176
813246
813250
813252
813256
813264
813268
813270
813274
813276
842802
842806
842810
842812
870834

Unigue 1D

5U25791
5025791
5U47021
TCA48255
TC48255
TC48255
TC51146
TC51146
TN47756
TNA7756
TN47756
TN47756
TN47756
TN47756
TN47756
TN51377
TN51377
TN51377
tn51377

TN51377
TN51377
TN51377
TN51377
TN51377
TN51377
TN51377
TN51377
TN47756
TN51377

State
6/3/2022 State=FL
6/3/2022 State=FL
5/26/2022 State=FL
6/12/2022 StateFL
6/12/2022 State=FL
6/12/2022 State=FL
4/2(2022 State=FL
6/14/2022 State=FL
6/10/2022 State=FL
6/11/2022 State=FL
4/1/2022 State=FL
4/24/2022 State=FL
4/1/2022 State=FL
6/17/2022 State=FL
6/18/2022 State=FL
5/27/2022 State=FL
5/25/2022 State=FL
5/24/2022 State=FL
5/26/2022 State=FL
5/24/2022 State=FL
5/25/2022 State=FL
5/25/2022 State=FL
5/27/2022 State=FL
5/26/2022 State=FL
5/27/2022 StateFL
5/26/2022 State=FL
5/26/2022 State=FL
6/10/2022 State=FL
5/14/2022 State=FL

Test
su
su
su
TC
TC
TC
TC
TC
TN
TN
TN
su
su
TN
TN
TN
TN
TN
TN
TN
TN
TN
TN
TN
TN
TN
TC
TC
TC

So | count them, or the frequency. And here is what | come up with.
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But...

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Duplicates!

SU =5, total cost $125.00 SU = $25.00
TC =10, total cost $200.00 TC = $20.00
TN = 35, $525.00 TN = $15.00

So, | budgeted $1265 BUT it really only cost
$850.00. That could impact so many other parts
of my budget. Not to mention staffing and time
allotment.

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs

After removing them the total counts go down! And maybe, that SU test requires some
higher level testing that only 1-2 staff members can perform and based on the old total of 8
| bring in someone extra...or ask them to work when they don’t really need to. This is all
hypothetical, but you get the idea.
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Part ll: Preparing Data for Analysis

1. Explain the impact of dirty data
2. Dissect a data cleanse

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs

Cleansing check list, activity with excel short cuts, use of find and replace, etc. Do a
observation breakout with the data. 25 minutes — 10 lecture, 5 observation, 5 review. Take
it back to quantifying the qualitative.
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Connie’'s Customized Checklist

1. Remove duplicates (if you are not counting frequency)

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs

As a reminder, this can take a long time! A keen attention to detail is needed. When you
are having conversation about “what the data is telling you” - be sure you are calculating
any time for data cleaning.
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Duplicate Values

« When you have one qualified response entered more than
one time.

« CRMs, CMXs, etc typically have a duplicate value finder or
preventer - but they are far from perfect.

Tip: Have protocols/SOPs in place to remove duplicates.
Staff turnover and people unfamiliar with your database
may not understand what to do when they encounter a

duplicate and that can cause dirty data!

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Conmectog. mpomesng. Poovotg

When dealing with CRM data, put a protocol in place to remove duplcaited
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Allison Eck; Brad Flowers

Kim Pickard; Michele Levitt

Jean Mitchell; Surena Becraft

0000835391 SC2021  A7th NSH  WS10 HistogoncNSH 09/14/21 1A

0000835391 SC2021  47th NSH 1Ws11 Adhesive NSH 09/14/21 1A David Prine

0000835391 SC2021  47th NSH1WS21 Diagnosti NSH 15-Sep 1A Richard Ormesher

0000835391 SC2021  A7th MSH 1WSs32 Discovery NSH 09/16/21 1A

0000835391 SC2021  47th NSH WS40 Using The NSH 09/16/21 1A Gerelyn Henry

0000835391 SC2021  47th NSH 1Ws11 Adhesive NSH 09/14/21 1A David Prine

0000835291 5C2021 [T T del) Gerelyn Henry

ﬂ:ﬁﬂ%gl SC2021  A7th NSH 1 YOGADAY Morning YNSH 09/15/21 1A Gerelyn Hen
835391 SC2021  47th NSH 1YOGADAY Morning Y MNSH 09/16/21 1A Gerelw$

0000820781 SC202T o T T s Sl Snleinlid el (iialeileleiel T A
SC2021  A7th NSHIETO1 Modificat NSH 09/21/21 0.5 A Elizabeth Chlipala
SC2021  A7th NSHIETO01 MSH 09/25/21 0.5 A Elizabeth Chlipala
SC2021  47th NSHIET01 Modificat NSH 09/27/21 0.5 A Elizabeth Chlipala
SC2021  47th NSHIETO1 Modificat NSH 09/30/21 0.5 A Elizabeth Chlipala
SC2021 AT7th NSHET02 Chemical NSH 09/15/21 0.5 A Steven Goodman
SC2021  A7th NSHIET02 Chemical NSH 09/15/21 0.5 A S Goodman
SC2021  47th NSHIET02 Chemical NSH 09/20/21 0.5 A
SC2021  47th NSH1ET02 Chemical NSH 09/24/21 0.5 A Steven Goodman
SC2021  A7th NSHIET02 Chemical NSH 09/25/21 0.5 A Steven Goodman
SC2021  47th NSHIET02 Chemical NSH 09/27/21 0.5 A Steven Goodman
SC2021  47th NSHIET02 Chemical NSH 09/27/21 0.5 A Steven Goodman

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY

Connactng Gmpowering Fravaing

Show them how you do it in excel.
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Excel Trick: Remove Duplicates

Remove Duplicates ? *
To delete duplicate values, select one or more columns that contain duplicates.
My data has headers

nselect All

Select All

Columns

CUSTOMERCD
SESSIONALTCD
SESSIONMAME
FUNCTIONCD
UDEF4TYT

[~ CERTIFICATIONCD N

0K Cancel

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY

Connacting. Empowedng. Fnovoing
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Connie’'s Customized Checklist

1. Remove duplicates (if you are not counting frequency)

2. ldentify formatting issues:
« Formatting for quantitative entries like dates, decimals

» Formatting for categorical information like states, names,
etc.

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs

As a reminder, this can take a long time! A keen attention to detail is needed. When you
are having conversation about “what the data is telling you” - be sure you are calculating
any time for data cleaning.
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Formatting Issues

* Inconsistencies with data fields.
» Open ended fields will always need attention.

Tip: Consider drop downs, and prefilled items when you can.
Test with people to see if there are issues that are preventable

(i.e. are dropdowns missing fields, etc.)

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Connactiog. Gmpomering. Fnowoing
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0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000820781

5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
s5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021

47th NSH 1'WS10
47th NSH 1'ws11
47th NSH 1'ws21
47th NSH 1'ws32
47th NSH 1'ws40
47th NSH 1'ws11

Histogont NSH
Adhesive NSH
Diagnosti NSH
Discovery NSH
Using TheNSH
Adhesive NSH

YOGADAY Morning Y NSH
47th NSH 1 YOGADAY Morning Y NSH
A47th NSH 1 YOGADAY Morning Y NSH

47th NSH 1ET05
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1ET02
47th NSH 1ET02
47th NSH 1 ET02
47th NSH 1 ET02
47th NSH 1ET02
47th NSH 1ET02
47th NSH 1 ET02

Stains Be NSH
Modificat NSH

MSH
Modificat NSH
Modificat NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH

09/14/21

09/16/21
09/14/21
09/15/21
09/15/21
09/16/21
09/15/21
09/21/21
09/25/21
09/27/21
09/30/21
09/15/21
09/15/21
09/20/21
09/24/21
09/25/21
09/27/21
09/27/21

1A
1A
1A
1A
1A
1A
1A
1A
1A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A

Allison Eck; Brad Flowers
David Prine

Richard Ormesher

Kim Pickard; Michele Levitt
Gerelyn Henry

David Prine

Gerelyn Henry

Gerelyn Henry

Gerelyn Henry

lean Mitchell; Surena Becraft
Elizabeth Chlipala
Elizabeth Chlipala
Elizabeth Chlipala
Elizabeth Chlipala

rereEagdman

Steven Goodman

Steven Goodman

Steven Goodman

Steven Goodman
*NAIIONAL SOCIETY FOR
HISTOTECHNOLOGY

Connactng Gmpowering Fravaing
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Excel Trick: Filter or Sort

v GS -
E| Sort Largest to Smallest ! Sheet View > W
. = W
. ) Sort by Color > oW e}
AutoSi - i |
@ gg @ 2 AutoSum %? O @“ Sheet View s W . W
O " insert Delete Format Fill Sort&| Find &  Analyze 7 Wi Y
v - > v & Clear~ Filter | Select v Data Wy Nurnber Filters > (El
. | > livg -
Cells Editi A sis 1E1
Sort AtoZ
Zl 2 ° Mumber Filters > (ET| Search ,(::1
Z| sotZton (ET| 'El
_ Search ;31 ET 10011763 LR[S
Custom Sott... Select All) | [l 0011764 =
T u " s a4
Filter (Ctri+Shift+L) 57 Filter — (ET 0011804 s
Turn on filtering for the selected ‘T’ 'G3 0011805 G
cells. - 1G§ 0000820781
= {63 0000835391 {6
Then, click the arrow in the column |
header to narrow down the data, Wi 0000341671 W
W)
@ Tell me more v W -[#10001113621 . W
W ..[v] (Blanks) w W
w "
oW, [ ok || canca | 1wy
t 0000941671 SC2021  47th NSH (W I
: 0
INATIONAL SOCIETY FOR
HISTOTECHNOLOGY

Connacting. Empowedng. Fnovoing




Connie’'s Customized Checklist

1. Remove duplicates (if you are not counting frequency)

2. ldentify formatting issues:
« Formatting for quantitative entries like dates, decimals

» Formatting for categorical information like states, names,
etc.

3. Find missing data and fill in or remove.

INATIONAL SOCIETY FOR
*S‘I‘OTECHNOLOG\‘
Conmectog. rmpomesng. Poovotg

As a reminder, this can take a long time! A keen attention to detail is needed. When you
are having conversation about “what the data is telling you” - be sure you are calculating
any time for data cleaning.
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° ° Why and What to
MISSIng Data Measure

- Data fields that are not complete.

* “Missing data can reduce the statistical power of a study
and can produce biased estimates, leading to invalid
conclusions.”

Tip: Collection desires vs realities (think about the amount
of time it would take a person to enter fully the information,
or accurately)

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
Connactiog. Gmpomering. Fnowoing

This leads us to the concept that we need to be realistic about our questions. If we are
finding that we are missing data, and it’s a lot, maybe we made a mistake in asking the

question.
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0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0000835391
0 20781

5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
s5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021
5C2021

47th NSH 1'WS10
47th NSH 1'ws11
47th NSH 1'ws21
47th NSH 1'ws32
47th NSH 1'ws40

511

Histogont NSH
Adhesive NSH
Diagnosti NSH
Discovery NSH
Using TheNSH
Adhesive NSH

GADAY Morning YNSH
47th NSH 1 YOGADAY Morning Y NSH
A47th NSH 1 YOGADAY Morning Y NSH

47th NSH 1ET05
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1 ETO1
47th NSH 1ET02
47th NSH 1ET02
47th NSH 1 ET02
47th NSH 1 ET02
47th NSH 1ET02
47th NSH 1ET02
47th NSH 1 ET02

Stains Be NSH

SH

SH
Modificat NSH
Modificat NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH
Chemical NSH

09/14/21
09/14/21
15-Sep

09/16/21
09/16/21
09/14/21
09/15/21
09/15/21
09/16/21
09/15/21
09/21/21
09/25/21
09/27/21
09/30/21
09/15/21
09/15/21
09/20/21
09/24/21
09/25/21
09/27/21
09/27/21

1A
1A
1A
1A
1A
1A
1A
1A
1A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A
0.5 A

Allison Eck; Brad Flowers
David Prine
Richard Ormesher
Kim Pickard; Michele Levitt
Gerelyn Henry
David Prine
Gerelyn Henry
Gerelyn Henry
Gerelyn Henry
lean Mitchell; Surena Becraft
Elizabeth Chlipala
Elizabeth Chlipala
Elizabeth Chlipala
Elizabeth Chlipala
Steven Goodman

n

Steven Goodman
Steven Goodman
Steven Goodman
Steven Goodman

NATIONAL SOCIETY FOR
%STOTECHNOLOGY
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Excel Trick: Filter or Sort

v GS -
E| Sort Largest to Smallest ! Sheet View > W
. = W
. ) Sort by Color > oW e}
AutoSi - i |
@ gg @ 2 AutoSum %? O @“ Sheet View s W . W
O " insert Delete Format Fill Sort&| Find &  Analyze 7 Wi Y
v - > v & Clear~ Filter | Select v Data Wy Nurnber Filters > (El
. | > livg -
Cells Editi A sis 1E1
Sort AtoZ
Zl 2 ° Mumber Filters > (ET| Search ,(::1
Z| sotZton (ET| 'El
_ Search ;31 ET 10011763 LR[S
Custom Sott... Select All) | [l 0011764 =
T u " s a4
Filter (Ctri+Shift+L) 57 Filter — (ET 0011804 s
Turn on filtering for the selected ‘T’ 'G3 0011805 G
cells. - 1G§ 0000820781
= {63 0000835391 {6
Then, click the arrow in the column |
header to narrow down the data, Wi 0000341671 W
W)
@ Tell me more v W -[#10001113621 . W
W ..[v] (Blanks) w W
w "
oW, [ ok || canca | 1wy
t 0000941671 SC2021  47th NSH (W I
: 0
INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Connie’s Customized Checklist

1. Remove duplicates (if you are not counting frequency)

2. ldentify formatting issues:
- Formatting for quantitative entries like dates, decimals

« Formatting for categorical information like states, names,
etc.

3. Find missing data and fill in or remove.
4. Remove duplicates again!

AL SOCIETY FOR
HISTOTECHNOLOGY

Connactng Gmpowering Fravaing

As a reminder, this can take a long time! A keen attention to detail is needed. When you
are having conversation about “what the data is telling you” - be sure you are calculating
any time for data cleaning.
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ISMEMBERFLG CUSTOMERTYPE STATUSSTT

CUSTOMERCD CONTACT CITY STATECD ZIP
10013333 Orland Park IL 60462 N
10012128 fergana 15011 N
222905 Glendale CA 91201 N
201568 Meedham MA 2494 N
10012018 bronx NY 10453 N
10001832 Reading MA 1867 N
10000679 Omdrman N
145814 San Jose 11501 N
10012780 Enugu 400001 N
10011882 Spotsylvania VIC 22351 N
112211 Lafayette LA 70503-2573 Y
10013780 Seattle WA 98119 N
180270 SOUTH SAN FRANCISCO CA 94080 N
223196 Washington DC 20007-2126 N
10011949 Beaumont CA 92223 N
10003077 Springfield MO 65804 N
190551 San Diego CA 92122-4586 N
10012022 Gaffney SC 29341 N
109680 Downey CA 90242-2041 Y
10001540 Richmond 1B 77069 N
10012147 Khartoum BC 12345 N
109013 karachi 75190 N
10011862 Risharon TX 77583 N
101728 Madison Wi 53527 N
10013961 Calabar 54201 N
10001661 Sydney, Fairfield ACT 2165 N
10011232 Auckland oC N
10014787 Spokane Valley |WA _l 99037 Y
10012275 Columbia TN 38401 Y

NONMEMBER
NONMEMBER
NONMEMBER
NONMEMBER
NONMEMBER
NONMEMBER
NONMEMBER
NONMEMEBER
NONMEMBER
NONMEMBER
ENHANCED
NONMEMBER
NONMEMBER
CORE
NONMEMBER
NONMEMBER
CORE
NONMEMEBER
ENHANCED
NONMEMBER
NONMEMBER
NONMEMBER
NONMEMBER
CORE
NONMEMBER
NONMEMBER
NONMEMBER
ENHANCED
CORE

ACTIVE
ACTIVE
Active
Active CHECK IN
ACTIVE
ACTIVE
ACTIVE

Active I}
scive What's
ACTIVE

=~ Wrong With

ACTIVE

=== This Picture?

ACTIVE
ACTIVE
FORMER
ACTIVE
Active
ACTIVE
ACTIVE
Active
ACTIVE
FORMER
ACTIVE
ACTIVE

ACTIVE INATIONAL SOCIETY FOR
Active HISCTOE‘;:HNOI:O?‘,Y

Active

Missing state

Formatting of zip

Font sizes

Formatting of certain words

Suppose | don’t want international records how can | fix that?
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Part lll: Analyzing Data

1. Interpret measures of central tendency.
2. Analyze data

NATIONAL SOCIETY FOR
*STOTECHNOLOGY
Commactrg mpowerng wrrorvs

Cleansing check list, activity with excel short cuts, use of find and replace, etc. Do a
observation breakout with the data. 25 minutes — 10 lecture, 5 observation, 5 review. Take
it back to quantifying the qualitative.
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Evaluation Life Cycle

Why bother? What is the outcome?

Why and What to
Measure

Draw Conclusions Gathering Data

What
Changes/Decisions as a How to Measure It
Result? Interpretation

How to Analyze the
Results

Observations

NATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Two Types of Quantitative Analysis

* Descriptive: focus on * Inferential: makes predictions
describing a sample of a based on the sample about
population. the ENTIRE population.

“In other words, we use one group of
statistical methods — descriptive
statistics — to investigate the slice of
cake, and another group of methods —
inferential statistics — to draw
conclusions about the entire cake.”

R
ISTOTECHNOLOGY

Connactng Gmpowering Fravaing

-Karryn Warren, PhD *.m.om SOCIETY FO

When a research question and/or a design created the type of analysis matters. There are
two types. Desriptive and Inferential. For our purpose we will be focusing on descriptive
statistics. If you would like to read more, | would suggest an evaluation book, like insert
name Research Design. If you think about. If you are going cake level, you are likely going
to be working with an evaluator or statistician and they will stil provide you with descriptive
statsistic, but then the insight for the infnerential.

For example, car color and accidents

65



Central Tendency

« A measure of central tendency is a single value that
attempts to describe a set of data by identifying the
central position within that set of data.

A single measure may not give you the full picture because
extreme values can impact each measurement.

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Frequency

The rate at which something occurs or is repeated (over time
or in a sample). For example, Embed Priority appears 18
times.

Priority Block Container *3 Task Lab Responsible Pathologist Case Flags
Embedded Priority PS20- Al PS20- Al H&E - - RENAL
Embedded Priority PS20- Al PS20- Al4 H&E RENAL
Embedded Priority PS20- Al PS20- A1T H&E RENAL
Embedded Priority PS20- Al PS20- A1l H&E RENAL
Embedded Priority PS20- Al PS20- Al4d ERG RENAL
Embedded Priority P520- Al PS20- ALT H&E RENAL
Embedded Priority PS20- Al PS20- Al HREFS RENAL
Embedded Priority PS20- Al PS20- Al4 H&E RENAL
Embedded Priority PS20- Al PS20- AT H&E RENAL
Embedded Priority 8820- Al 8820- AN H&E ENT Senice
Embedded Priority 8520- Al 8520 A113 H&E ENT Senice
Embedded Priority 5520~ Al 5520- A9 H&E ENT Senice
Embedded Priority 5520- Al 5520 Al ERG Derm Senvice
Embedded Priority 5520- A2 8520- A21 ERG Derm Service
Embedded Priority S$S20- A3 §520- A3-1 H&E Derm Senvice
Embedded Priority S§520- A 8520 Ad1 H&E Derm Senvice
Embedded Priority 8820- AB 8820- A5-1 H&E Derm Service
Embedded Priority 8§520- A6 5520 AB-1 ERG Derm Senvice
Embedded Routine Surgical $520- Al $520- A2 HE&EFS GYN Surg Senvice
Permanent FS/TP Slides
Embedded Routine Surgical $§520- A0 §820- A10-1 HER2 IHC GYN Surg Senvice
FS/TP Slides
Embedded Routine Surgical 5520- AN 8820- ANl H&E GYN Surg Senice
Lol oudes INATIONAL SOCIETY FOR
Embedded Routine Surgical $520- Al2 5520 Al2-1 H&E GYN Surg Senvice
2 Car e HISTOTECHNOLOGY
Embedded Routine Surgical $520- A2 $520- A21 H&E GYN Surg Senice Gonmectn frpowemg frois
ES/TP Slides
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Mean

* Average

» Total all numbers in the data set and divide by the number of
responses.

- Very sensitive to outliers

Example:
20,16, 15,12, 22,13,16, 19, 31, 32,12, 16, 20, 20, 16

Excel Formula
=AVERAG E(A2A16) INATIONAL SOCIETY FOR
HISTOTECHNOLOGY

Connacting. Empowedng. Fnovoing

68



Balanced Distribution: Use Mean

Salary Distribution

Mean
]

200

Frequency
&

g

o

AN
By HISTOTECHNOLOGY

Conmacteg fmpomerg bnovating.
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Median

* The value that appears in the center of the data set.

* If the number of data points is odd, the median is the middle
data point in the list.

« If the number of data points is even, the median is the
average of the two middle data points in the list (add the two
middle values and divide by 2)

* Very useful if there are extreme outliers

Example:
A2, 1, 13, 115, 2%, 1%, 16, 1%,38, 38, 20, &), 29, 2%, B2, 32

II 16 +18=17 al

NATIONAL SOCIETY FOR
ISTOTECHNOLOGY

Connacting. Empowedng. Fnovoing.
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Not Balanced Distribution: Use Median

Salary Distribution

fu
.
m
2 — 1
YT YT I IIRIIIIIILY
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Mode WHATARE w:aanmn T0 DO TONIGHT

Mode
data set. You can have more than one

mode. ﬁ qﬁ

- Mode is best with large datasets becausefe>, /2% r.,;‘\
smaller data sets may not even have a C:%%“{“;J,",:’{ﬁ,'f{‘"',',':;‘{f,'}'v:‘,',ﬁ':;

mode!

» The number that appears the most in the

Example:
2@, 1, M3, 115,28, 13, 16, 119,319, 24), A), 118), 22, X, 32

NATIONAL SOCIETY FOR
*STOTECHNOLOGY
L T —
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13: Other (please
describe):Which type of
POL/Specialty Lab?

MEDIAN
MODE
MEAN

1

14: Laboratory
14: Non-Registered 14: Registered Assistant:How many full
HT/HTL:How many full time HT/HTL:How many full time time personnel work in your
personnel work in your lab  personnel work in your lab  lab with each of the
with each of the following  with each of the following following job functions?
job functions? Leave blank job functiohs? Leave blank Leave blank if no staff

1
3

if no staff perform a if no staff perform a perform a particular
particular function. particular function. function.
2 4 2
1 1 1
4 158054711 645 4 506527415

ﬂ NATIONAL SOCIETY FOR
HISTOTECHNOLOGY

crractg frposerng
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Box and Whisker Plots!

BOX & WHISKER PLOTS

CREY  FE

ﬂ =3
et

e TF

B uwm ]

L

https://www.youtube.com/watch?v=fJZv9YeQ-qQ Mo soae cor

Connacting. Empowedng. Fnovoing.




Range

* Describes the difference between the smallest and
largest value and describes how well the central
tendency represents the data. If the range is large, the
central tendency is not as representative of the data as it

would be if the range was small.
- Sensitive to outliers

Example:
2@, 1&, M3, 15, 2%, 1%, Tk, 1%, 318, 320, 124, 144), 22, A, B2

INATIONAL SOCIETY FOR
HISTOTECHNOLOGY
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Quiz Time!

Range

Arrange in ascending order
True

Median

5

True

Descriptive

Nouhkwbh =

NATIONAL SOCIETY FOR
*STOT ECHNOLOGY
Commactrg mpowerng wrrorvs




Part lll: Analyzing Data

1. Interpret measures of central tendency.
2. Analyze data

NATIONAL SOCIETY FOR
*STOTECHNOLOGY
Commactrg mpowerng wrrorvs

Cleansing check list, activity with excel short cuts, use of find and replace, etc. Do a
observation breakout with the data. 25 minutes — 10 lecture, 5 observation, 5 review. Take
it back to quantifying the qualitative.
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OBSERVATION - Analysis

* Observation = FACTS

* Analysis is just what the numbers
or information say.

CTS, MA'AM

INATIONAL SOCIETY FOR
HISTOTECHMOLOGY
Conmactiog. lmpowering bnovolng.

This is the step that people tend to skip. They go right from the assessment to making
assumptions and rationalizing. And that’s not good because you lose information. We
focus in on one data point and move on...but the story is usually much bigger.
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ASCP BOC QUALIFICATION STATISTICS: 2006 - 2021
QUALIFICATION RANGE OF | TOTAL # TAKING TOTAL
TYPE YEAR | MEAN SCORES QUALIFICATION TOTAL PASS TOTAL FAIL QUALIFIED
| | |

7006 365 740 | 640 %0 v To% 8 0%
2007 355 260 | 680 5 IR 1% 0 0%
2008 258 260 | 820 70 55 53% Z %
7000 a7 300 | 680 76 52 52% Ta %
2010 499 270 680 88 80 91% ] 9%
2011 463 210 680 84 69 82% 15 18% 1822
2012 475 220 680 104 84 81% 20 19%

Ih':::ll.El:?:;ﬁ';U 2013 433 220 B20 123 74 B0% 49 40%

(QIHC) 2014 430 100 680 133 72 54% 61 46% (First Year

2015 455 217 906 113 a7 50% 56 50% Qualified 1994)
2016 459 250 B14 124 66 53% 5B 47%
2017 389 212 759 131 46 35% 85 B65%
2018 10 89 | 759 S 57 a2% 78 58%
2019 328 736 | 759 S &7 50% &8 50%
2020 418 212 759 131 64 49% 67 51%
2021 408 217 749 14 50 35% 91 65%

* More test takers passed the QIHC by percent in 2010 than

any other year measured. (continuous data example)

* The total number of test takers in 2021 was 141. (discrete

data example)

Remember, counting vs measuring...

INATIONAL SOCIETY FOI

ETY FOR
HISTOTECHNOLOGY
Conmectog. rmpomesng. Poovotg
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Why can’t | make conclusions like...
The QIHC exam is too hard.

» Because the data doesn’t show us that. Maybe the test
takers didn’t have enough study tools, maybe the
technology is outdated for taking the exam.

* More importantly, we aren’t at that step yet!
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Evaluation Life Cycle

Why bother? What is the outcome?

Why and What to
Measure

Draw Conclusions Gathering Data

What
Changes/Decisions as a How to Measure It
Result? Interpretation

How to Analyze the
Results

Observations

NATIONAL SOCIETY FOR
HISTOTECKNOLOGY

Conacteg fmpomerng bnovating.




Instructions

- Looking at the data set, type in an
observation about the data.
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Statis (1), cert date g
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Total Hospital Private Independent
Sample Size 1,088 809 279

Grossing Questions
Who performs grossing in your lab?

Mon-Registered HT/HTL 9% 7% 15%
Reqgistered HT/HTL 31% 26% 44%
Laboratory Assistant 3% 2% 5%
Labaoratory Technician 8% 7% 1%
Grossing Assistant 22% 20% 27%
Supervisaor 9% 9% 11%
Manager 3% 3% 3%
Pathologist 31% 5% 21%
Pathologist's Assistant 53% 62% 25%
Resident 12% 16% 2%
Other (please specify) 2% 2% 2%
What are the average number of cassettes grossed per hour?

Mean 46 9 46.1 487
Median 300 300 350
What are the average number of containers grossed per hour? NATONAL SOCIETY FOR

ISTOTECHNOLOGY

Mean 276 233 D5 1 | cmveces trpomse oo




Diversity of Thought Makes Data Better!

* We all look at things differently, even numbers
- Using many sets of eyes and brains can analyze data better
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For Your Reading Pleasure

* https://uxdesign.cc/data-for-design-f33fd7419cc8

* https://www.ncbi.nlm.nih.gov/pmc/articles/PMC7886543
/

* https://towardsdatascience.com/9-common-mistakes-
beginner-data-scientists-make-91255ddd1311

» Excel Formula Tutorial:
https://www.youtube.com/watch?v=KYALCR6Bdxk
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